
 

 

Zeiss LSM 510 upright confocal manual 

Power Up 

1. Turn on the mercury lamp via the FluorArc box located on the crossbeam of the air table. (After the 
lamp's initial 2-minute warm-up period and whenever you're not looking at your specimen, set the 
voltage down to 50% - press F2 on the variable power supply keypad.) 

2. Flip on the Remote Control switch located on the marble-topped laser console which is on the table 
to the left of the microscope. 

3. If you need to use the UV laser, turn on the water chiller in the equipment closet, room 4322. Then, 
turn on the UV laser by flipping the main breaker switch on the Enterprise power supply and turning the 
start up key to the "on"position. See the section titled "UV Laser Usage" for more instructions on using 
the UV. 

4. Finally, turn on the computer using the power button on the tower.  

5. Once the computer has booted, log on by pressing CTRL, ALT, DELETE on the keyboard. Enter 
your user name & password for the ASADMIN server. Make sure that the log-in Domain field says 
ASADMIN and not LSM510 or some other domain name. 

Open the Software 

Double-click the 510 icon on the desktop, the LSM switchboard appears . . . 

And the software looks like this. . .  

 

An error log report is generated as the software initializes; a couple of errors are usual - "COM2 Read 
Time Out" and "Enterprise IsHwAccessible failed". The latter is normal if you don't have the UV laser 
on.   

 
 

� Make sure Scan New Images is selected.  
("Use Existing Images" is an off-line 
emulation mode)  

� Click on Start Expert in the Switchboard.  



Finding Your Specimen in the Eyepieces 

The objectives, fluorescent filters, condenser, neutral density filters, and field diaphragm on the 
Axioplan2 stand are motorized and can be controlled in the software via the Acquire> Micro  submenu. 
You may find it easier to control everything through the software or manually as described here. You 
may want to find and view your specimen under transmitted light or fluorescence, or both.  

  

Putting your slide on the stage 

1. Turn the nosepiece so that the objectives are out of the way of the stage.  

2. The stage has different stage trays for thin & thick specimens. If you need to change the stage tray, 
lower the stage into the Load position using the � button located on the front left of the microscope 
stand. Carefully insert the tray in a diagonal manner into the stage, lining up the red dot on the corner of 
the tray with the dot on the stage itself. The tray should be well-seated in the stage, fully engaging the 
tension-fit springs located near the red dot on the stage. 

3. Slide your specimen onto the stage tray with its coverslip facing upward, making sure that it is secure 
underneath the metal tabs of the specimen holder. Also, make sure the coverslip area is centered over 
the condenser.  

4. Raise the stage to the Work position using the �  button located on the front left of the microscope 
stand. 

5. View your specimen in the eyepieces with the tubus slider into the VIS position. 

Generally, it is safest to start focusing with the lowest power objective before moving on to higher-
powered immersion objectives. There is one dry (10x) and two water immersion (25x multi-immersion & 
63x with a focus correction collar) objectives which should all be parfocal. Let us now if they are not! 



The ��  buttons located underneath the right focus adjustment knobs advance objectives.   

Focusing and viewing your specimen under transmitted light 

1. Turn the reflector turret to the analyzer (position #2) using the ��  buttons located underneath the 
left focus adjustment knobs. The current filter position number is displayed in the small round view 
window on top the turret. 

2. Open the transmitted light shutter by depressing the "Hal" button on the right side of the microscope 
stand.  

3. Adjust transmitted intensity using the black knob on the right side of the microscope stand near the 
FL and Hal shutter buttons.  

Intensity can be adjusted more precisely in the software using the % Transmission scale found under 
Acquire> Micro  submenu. 

4. Use the 10x objective to initially focus on your specimen. Take care in this initial focusing that the 
stage Work position isn't so high that the objective will hit your specimen - this may be the case if the 
previous user was using a thicker prep (e.g. chamber slides) than your own.  

Carefully rotate the objective holder by its knurled edge (not by objective) to the 10x objective or use 
the ��  buttons located underneath the right focus adjustment knobs to advance the nosepiece. While 
looking in the eyepieces, adjust the coarse focus knob until your specimen comes into focus.  

5. While attempting to focus, you may find that you can't seem to focus far enough in to your 
sample. When this happens, you will probably hear a beep-beep-beeping sound. If so, the previous 
user has set a focus limit outside of your sample's focal range. To override this setting, turn the coarse 
focus knob while holding down the �  (Work) button on the lower left front side of the scope stand.   

Users will sometimes set a focal limit when they are using automated macro functions for time imaging 
experiments, particularly with thick specimens. Focal limits keep the stage from accidentally focusing 
too far into a sample, possibly ruining the sample and/or objective lens.   

To set a new focal limit, depress the �  button when you reach your desired focal limit while the stage is 
raised in the Work position. One beep will indicate that a new focal limit has been set. 

6. Use the remote XY Stage Controller to find a region of your specimen that you wish to image. The 
joystick allows for coarse X-Y navigation of your slide. The XY buttons used in conjunction with the 
round touch dial control fine X-Y navigation and is most useful with higher power objectives. 

7. You will probably use one of the water immersion objectives (25x, 63x) for confocal 
imaging. Important: This step assumes you are starting at go od focus in the lower power (10x) 
magnification as outlined in Step 4.   

Lower the stage to the Load position, apply a drop of water, and advance the nosepiece to either the 
25x or 63x objectives manually or using the ��  buttons located underneath the right focus adjustment 
knobs. When mechanically changing objectives, the stage will lower and return to the Work position 
automatically.  

When imaging a specimen over a long period of time use Zeiss Immersol W, an immersion oil with 
the refractive property of water. Unlike water, it will not evaporate over the time course of your 

experiment.  

8. Adjust the fine focus. If you're using the 63x objective, you may also need to adjust the correction 
collar for the thickness of your coverslip until the focus is absolutely pristine. Generally, the correction 
collar is left in a setting that is good for #1.5 coverslips. 



View the fluorescence signal of your specimen 

1. If necessary, close the transmitted light shutter using the Hal shutter button.  

2. Open the fluorescent light shutter using the FL button located just above the Hal button . 

3. Using the ��  buttons located underneath the left focus adjustment knobs, turn the Reflector Turret 
to the appropriate position for your fluorescent label(s). Look for the current filter position displayed in 
the small round view window on top the turret. 

  

4. Follow steps 4-7 under the "Focusing and viewing your specimen under transmitted light" section if 
you haven't already focused your specimen with transmitted light.   

When you've located something you'd like to confocal, simply move the tubus slider to the LSM 
position. There's no need to close the FL or Hal shutter that is currently in use. 

Acquiring a confocal image 

Turn On the Lasers 

a.Select Acquire> Laser  submenu will open the "Laser Control" window with a list of available lasers.  

b.Turn on the appropriate laser(s) to excite the fluors labeling your sample.  

c.To turn on the Argon laser, click to warm it up. After the initial warm-up period, the on button will 
appear allowing the laser to be fully activated. Set the output intensity to an appropriate level - most 
confocaling is performed somewhere between 5.5 and 7 amps. The laser should never exceed 8 
amps!!  If it does, please put it in standby and immediately tell Sam. 

d.To turn on either of the HeNe lasers, simply click the appropriate "On" buttons - no warm-up is 
required for ignition. 

1: none 

2: analyzer 

3: FITC 

4: rhodamine 

5: UV band pass 

6: UV long pass 

7: none 

8: none 

Laser  Lines (nm)  Colour of  
fluorophores  

Examples of  
fluorophores  

UV  351 364 Deep blue DAPI 

Argon 458 477 
488 514 

Green (Cyan 
and Yellow) 

GFP, Alexa 488, 
FITC, CY2 

543 
gas 543 Red Alexa 555, 568, 

CY3 
633 
gas 633 Far-red Alexa 633, CY5 



e.To turn on the Enterprise UV laser, click Standby. Read the detailed instructions in the "Preparing to 
image with the UV laser" section.  

f.Close the "Laser Control" window when you're finished turning on the laser(s) and setting output 
levels. The lasers take a few minutes to reach power and stabilize.  

 

We try to minimize the number of times a laser is turned on or off - if somebody will use the laser 
within 2 hours leave it on (Argon and UV lasers in standby). Check the reservation schedule to see 

the laser usage scheduled before and after your session. Turn off any lasers you don't need that 
may have been left on for you by the previous user, as long as anyone scheduled after you won't 

use them within 2 hours of your imaging session.  

Choose a Filter Configuration 

1. A filter configuration for the particular fluorophores you are using can be loaded via the 
"Configuration Control" window. Open it by selecting the Acquire> Config  submenu.  



 

2. Single Track mode is for single channel imaging or simultaneous excitation of multiple channels; in 
Multi Track mode the laser scans multiple channels sequentially, which can be useful when 
bleedthrough is a problem. Select whichever is appropriate for your imaging needs.  

3. Store on the right side of the "Configuration Control" window opens the "Track Configurations" 
window. Here, the dropdown menu has a list of typical color configurations for general use. Choose 
whichever one is appropriate for your specimen. 

4. Click Apply to load the laser & filter settings for that configuration. 

Capture an image: Scan control 

Acquire>Scan  opens the "Scan Control" window - the main dialog box for acquiring images. There are 
several adjustments to make to get a good image. Each adjustment may effect the other settings so 
some interation in the process is required.  



Adjustments under the channels tab . . . 

 

1. Adjust % laser transmission(s) in the Excitation panel at the bottom of the window. Doing so sets the 
% laser power let through by the AOTF. Here are some starting values: 

  

2. Set the pinhole diameter with the Pinhole slider scale. The smaller the pinhole, the thinner the 
optical slice will be and the less light will be collected. A pinhole set to 1 Airy unit (click the 1 button) will 
have optimal resolution. However, you will probably need to adjust this according to your sample's 
fluorescence, using larger Airy values for dim samples. For multi-fluorophore imaging, it is usually 
advisable to set the pinholes for each channel to produce equivalently thick optical slices.  

3. Press "Find" to acquire a preliminary image using automatic setting of gain. An image display 
window will open and the output of the scan will be displayed. If you are performing multi-channel 

364 - 50% 

458 - >50% 

488 - 25% 

514 - >50% 

543 - 100% 

633 - 100% 



imaging, select Split XY button in the "Image" window's Display toolbar. 

  

4. Click the Fast XY button and while the laser is scanning, use the XY Stage Controller and adjust 
the fine focus on the microscope body.  Clicking "Stop" in the Scan Control window will turn off the 
Fast XY continuous scanning (minimize bleaching when you can). 

The preliminary image, whether too dim or too bright, usually needs to be optimized. The PMTs need 
to be adjusted according to the fluorescence intensity of the sample.  

5. Select each channel separately by clicking on the corresponding coloured button.  

6. The range indicator display is helpful for setting the gain and offset. Select Palette in the image 
window's Select toolbar. From the Color Palette List, select "Range Indicator". In this palette, pixels 
with intensity of 0 are blue and pixels with intensity of 255 (for 8 bit images) are displayed red. 

7. Start Fast XY and set the Detector Gain  until no more than a few % of your stained areas has red 
pixels. Move the Amplifier Offset  until the background is a mixture of blue and black pixels. (Always 
leave the amplifier gain as 1). Make these adjustments for each channel.  



 

8. Reset the Palette to "No Palette".  



Adjustments under the mode tab . . . 

Most of these will be fine as the default values. Averaging is the most important thing to adjust. 

  

512*512 pixels is good for most imaging, choose other pixel sizes in the "image size" sub-panel 

Under Speed, the default scan speed (when not zoomed in) is 9. Reducing the scan speed can improve 
a noisy image; faster scan speeds are used to find regions of interest (like during the Fast XY function) 
or when photobleaching of the sample is a concern. 

Under Pixel Depth, Scan Direction & Scan Average, select your images to be 8 bit (256 gray levels) or 
12 bit (4096 gray levels). Select the Scan Direction to be unidirectional or bidirectional. Unidirectional is 
typically used, bidirectional scanning can be handy in live imaging since it cuts the scan time in half (but 
may require phase adjustment). 

To set the averaging for your final image , choose between line averaging, using the mean intensity 
of 1,2,4,8, or 16 scans.  

The amount of averaging necessary to obtain a good image depends on the signal to noise ratio of 
your sample image. Low contrast images will require more averaging but be aware that this could 
cause photobleaching. You can determine the amount of averaging necessary to yield the best image 
of your sample empirically. As a rough guide, averaging should be set to 100th the gain value, meaning 
most samples will require averaging of 4 or 8.   



The zoom and scan field rotation can be set in the Zoom, Rotation, & Offset panel (Offset here refers 
to fine XY movement of the scan area). You may find it more convenient to use the crop function in the 
"Image" window -  

Crop Your Image (optional) 

This function is a true optical zoom performed upon image acquisition - the laser will scan a user-
defined region of interest and display the scan data in the designated frame size (512x512, etc). It is a 
convenient way of setting the zoom, rotation and offset displayed under the Mode tab.  

Press "Crop" from the Image window display toolbar. A crop box appears in the current image window, 
which can be moved, rotated and resized with the mouse.  

 

Pressing "single" will rescan with the modified zoom etc settings 

(Pressing the "reset" button in the mode panel is useful for undoing all these changes, ready for the 
next sample.)  
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� Images are saved as .lsm files  within a .mdb 
database. Images can be later exported as TIFFs 

� Click the "Save" icon on the bottom right of the image 
window 

� If you don't have a database already, you need to 
create one 

� Make sure you are saving images to the correct 
database 

� Name the image and press save 

Users should generally save their images either to their 
own user folder on the \\Bio-lemming\Confocal fileserver or 
directly to a USB memory drive. Any images saved on the 

hard-drives are unsafe and are subject to deletion 
WITHOUT WARNING. The Imaging Suite anteroom (4226 
FFSC) has a PC workstation with both a USB port and a 
DVD writer that can be used for transferring data off the 

network to portable storage devices. 



UV Laser Usage 

General guidelines for UV usage 

If you intend to use the UV laser, indicate this in the Comments  field when booking your reservation 
on-line so other UV users will be aware of when you are using the laser that day. 

Turning the UV laser on & off throughout the course of the day should be kept to a minimum. For this 
reason, there is a "2-hour Rule" for the UV laser:  

If someone is signed up to use the UV within 2 hours after your UV session, leave the UV laser on 
for that user. If the next UV user is scheduled to start more than 2 hours after your UV session, turn 

the UV laser off according to the directions below. 

The computer and other lasers do not have to be off or shut down before turning on the UV laser.  

Turning the UV laser ON 

1. First, use the rocker-motion power switch to turn on the water chiller unit in the equipment closet, 
room 4322. Doing so provides cooling water for the laser. Make sure that the water lines to the chiller 
are open (yellow valve handles are parallel to the plumbing). These lines should always stay open. 

2. Turn the UV laser on via the UV power supply, the black box that sits on the floor to the right of the 
laser table. Flip the main power breaker switch to the "ON" position. Now turn the key switch to the 
"ON" position. The Current Limit indicator light will illuminate until you actually ignite the laser using the 
software. 

Preparing to image with the UV laser 

1. Log into the Zeiss software. It is necessary that the UV laser be turned on BEFORE logging into the 
software, since that laser is recognized as being on-line and available for use when the software 
initializes.  

2. Follow instructions in the "Turn On the Lasers" & "Choose a Filter Configuration" sections. The UV 
(Enterprise) laser needs to go on Standby to warm-up before being ignited. When the laser status 
reads "Ready", ignite the laser using the ON. The power supply will make a screeching noise at this 
time - this is normal. The Laser Emission indicator light on the Enterprise power supply will illuminate 
and the Current Limit light should go off upon ignition. In the software, set the laser output to 50%. 

The UV laser requires a 20-30 minute warm-up & stabilizing period for optimal excitation of your 
specimen. 

3. Close the "Laser Control" window when you're finished turning on the laser(s) and setting output 
levels. 

Turning the UV laser OFF 

1. When finished, consult the sign-up sheet to determine if you need to turn off the UV laser according 
to the "2 hour Rule" ( General Guidelines For UV Usage ). If you need to turn off the UV laser, select 
Acquire>Laser  from the main menu and turn HeNe(2). The UV laser should be put in Standby before 
it is turned Off.  

2. Turn the key switch on the UV power supply to the "OFF" position, then flip the main power breaker 
"OFF". After having completely turned off the power supply, wait 3 MINUTES before turning the 
chiller off to allow proper cool down of the UV las er. 

3. Refer to the section "Ending Your Session: Exit the Software" and follow the instructions for logging 
off/shutting down the rest of the system at this time.  



Z-sectioning 

To collect a series of images at different points along the z-axis the settings can be inputted in two 
ways: Z Sectioning or Mark First/Last.  

� Z-sectioning - takes x slices at a particular z interval  
� Mark first/last - set the top and bottom of your sample and select either the interval or number of 

slices (the other is calculated for you)  

Both of the methods described here assume that the user has optimized and set all imaging 
parameters, including pinhole size, detector gain/offset, scan time and averaging described above.  

Mark First/Last Method 

1. Select Z Stack at the top of the "Scan Control" window - doing this will activate the Z Settings panel.  

 

2. Determine the start and end points of the Z stack. (Z sectioning is performed moving into the 
specimen, away from the coverslip.) To find the starting point for the Z stack perform a Fast XY scan 
and focus toward the coverslip (rotate fine focus knob toward you) until you reach the point at which 
you'd like to begin the Z stack. Stop the Fast XY scanning.  

3. Click Mark First in the Mark First/Last tab in the Z Settings panel.  

4.Start another Fast XY scan and turn the fine focus knob away from you focusing down through your 
specimen until you reach the point at which you'd like to end the Z stack. Stop the Fast XY scanning. 

5. Click Mark Last to set the end point of the stack. 

6. Assuming you have already adjusted your pinholes as described in "Acquire Menu: Collect An XY 
Section", look up the optimal z interval thickness by clicking Z Slice at the top of the Z Settings 
box. This will open the "Optimal Slice" window.  

7. Optimal z interval thickness for the objective currently in use will be displayed in this 
window. Clicking Optimal Interval in the lower left corner of the window will set the z interval of your z 
stack to the recommended thickness.  



8. Start will begin scanning of the z stack. Settings last entered in the Channels and Mode panels will 
be applied to this z stack collection. 

9. The collected z stack is temporarily stored in the computer's memory. To permanently store the 
stack, use Save or Save As in the image display window to save it to a database. 

Z Sectioning Method 

1. This method assumes the user has prior knowledge of the specimen's thickness and/or is willing to 
guesstimate thickness. Select Z Stack at the top in the "Scan Control" window - doing this will activate 
the Z Settings panel.  

2. Click on the Z Sectioning tab and select Keep Interval. This will keep the z slice size constant, even 
if you later decide to change the Num Slices or the upper and lower limits in your stack. 

3.Type in the desired interval for your z stack in the Interval (um)  field of the Z Sectioning tab. If 
necessary, look up the optimal z interval thickness by clicking Z Slice at the top of the Z Settings 
box. This will open the "Optimal Slice" window. Assuming you have already adjusted your pinholes as 
described in "Acquire Menu: Collect An XY Section", your optimal z interval thickness for the objective 
currently in use will be displayed in this window. Clicking Optimal Interval in the lower left corner of the 
window will set the z interval of your z stack to the recommended thickness.  

  

4. The Num Slices  will be calculated automatically based on the chosen interval input. 

5. Designate your current focal position (if you're in focus, you're probably somewhere near the middle 
of the specimen) in the Current Slice  field.  

6. Clicking Start will begin scanning of the z stack. Settings last entered in the Channels and Mode 
panels will be used to collect this z stack collection. 

7. The collected z stack is temporarily stored in the computer's memory. To permanently store the 
stack, use Save or Save As in the image display window to save it to a database. 



Time series 

The Time Series is a versatile software function that is useful in a variety of situations - from collecting 
single confocal images or entire z stacks over time to more sophisticated applications such as FRAP. If 
desired, a delay between the beginning of one scan process to the beginning of the next can be set.  It 
is important to note that Time Series works at only one location on the slide. To apply the Time Series 
function to multiple stage locations, you will have to use the Multitime macro. 

The following instructions are for applying a basic Time Series. It is assumed that the user has 
optimized and set all imaging parameters beforehand (pinhole size, detector gain/offset, scan time, 
averaging, and if desired, z stack). Refer to previous sections for more details on adjusting these 
settings. 

1. Select the Acquire>Time Series  submenu.  

2. In the Start Series panel, choose between a Manual start or a timed start via Time. Most users want 
a manual start.  If a timed start is desired, enter a start time in the Time (h:m:s) field. The time series 
will start when the set time is reached according to the computer's clock. 

3. In the End Series panel, enter the number of time points desired in the Number  field if a Manual end 
is selected. For a timed end point, depress Time and enter the end time in the Time (h:m:s) field. 

In determining an experiment's length and the number of time points needed it is important to consider 
the scan time and averaging settings (see the Speed section of the Mode panel in "Scan 
Control"). Both parameters influence how long it takes the laser to clear the scan field and thereby 
define the minimum time between time points.   

4. The next panel you encounter will be either Time Interval or Time Delay, depending on the settings 
of your Time Series register (see Options> Settings ). Time Delay is defined as the end of one scan 
process to the beginning of the next, while Time Interval is the time between the beginning of one scan 
process to the beginning of the next. Either panel, Time Interval or Time Delay, permits time series 
scan parameters to be activated or changed from experiment to experiment.  

You may load & Apply previously saved time series settings using the pulldown menu in either of these 
panels. Or you may choose to manually enter scan parameters into the Time  and Unit  fields. If you 
foresee performing other experiments with identical time scan settings, you should Store your manually 
entered settings to the dropdown list for easy reference in the future.  

5. Click Start T in the right-hand side of the "Time Series" window to start your time series. 

6. The collected time series is temporarily stored in the computer's memory. To permanently store the 
series, use Save or Save As in the image display window to save it to a database. 



Ending your session 

Exit the Software 

1. Check the on-line reservation schedule to see if/when the next reservation is scheduled.  

2. If you have been using the UV laser and no one else is signed up to use UV in the next 2 hours, turn 
it off now via the key and main breaker switch. Leave the chiller running to cool the UV laser down for 
the remainder of the shut down process (at least 3 minutes). Refer to the "Using the UV Laser" section 
for full details of UV laser power down. 

3. If someone is scheduled to use the microscope right away, leave on only those lasers they specify 
on the booking calendar. Go to Acquire>Laser  in the main menu and turn off the relevant laser
(s). Note that the 488 Argon and the UV lasers should be put in Standby before they are turned 
Off. (Similarly, if these lasers are to be left on for the next user, put them in Standby but don't actually 
turn them Off.)  

4. Close all open dialog windows using the X in the upper right hand corner of each window. Select 
File>Exit  to close the software. The LSM 510 Switchboard window will appear - click on its Exit 
button. If you're leaving lasers on for the next user, a window will warn that the system shouldn't be 
shut off when the lasers are on - click Ok. 

Log Off/ Shutdown System 

Remove your sample from the stage by lowering the stage to the Load position, leave 10x objective in 
place. 

If someone else is scheduled to use the microscope within 2 hours... 

1. Select the "Log Off" command from the Start menu of the desktop and leave the mercury lamp and 
Remote Control on. The log-in window should appear. Proceed to step 4 of the next section.  

If it is near the end of the day or on the weekend, please contact the next person on the schedule to 
ensure that they are actually planning to use the microscope. If you can't reach them, then shut off 

the system. 

If you are the last scheduled session of the day...  

1. Select "Shut down computer" command in the Start menu of the desktop. The computer and 
monitors will power down automatically.   

2. If the Argon laser has finishing cooling (its fan will have turned off), flip the Remote Control switch to 
the "OFF" position. 

3. Turn off the mercury lamp via the FluoArc power supply.  

4. Clean the objective(s) used by gently blotting any excess water from the objective surface with lens 
paper and/or a cotton-tipped swab. The 10x objective should not be wiped.  

5. Turn off the UV chiller switch in 4322, if necessary. 

6. Sign out in the logbook. Please let us know of any problems, the Report Problem form at 
http://microscopy.duke.edu/problem.html is quick to use. 

7. Turn off the room lights and make sure the door is locked behind you.  



Image Processing & Analysis 

Scalebars & Measurements 

A scale bar, measurements (e.g. angle, area, line) and/or text can easily be drawn onto an image that 
has already been collected using the Overlay option in the image display window. You are encouraged 
to explore the drawing buttons in the Overlay toolbar - creating a scalebar on your image is described 
here. 

1. Click Overlay in the Select toolbar of an open image window.  

2. Select the desired scalebar thickness from the line width option buttons appearing half way down the 
Overlay image window submenu. 

3. Click on the desired color of your scale bar from the color selection at the bottom of the Overlay 
submenu. 

4. Click 1um in the Overlay submenu, then click in the vicinity of the image where you wish the 
scalebar to be drawn.  

5. Drag the mouse over some distance on the image until the resulting scalebar registers your desired 
value. Release the mouse button to draw this scalebar overlay on the image.  

6. Use Save or Save As in the image window to save it to a database. 

 

Figure 9) Image With Scalebar & Overlay Toolbar 

3-D stack display options 

Animate 

Some users will find it helpful to assess their time or z-stack data by animating it.  

1. Select Anim from the Select toolbar of a stack's "Image" window. The "Animate" window will open 
and the stack will immediately be animated. 

2. Speed 1 and Speed 2 in the bottom section of the "Animate" window allow the user to control the 
speed of the animation.  

3. To further control the animation, use the function buttons in the top section of this window to animate 
forward and/or in reverse, stop, fast forward, and fast back through a stack.  + and - will animate the 



stack in forward or reverse by whatever increment you choose in the Increment slider in the bottom 
section of this window.  

4. The Increment  slider reduces the number of slices included in the animation to every nth slice as 
selected. 

Gallery 

Stack slices are organized in rows and presented in the order in which they were generated inside the 
image window. A 2-dimensional gallery of z-stacks over time can also be generated. Each slice's z-
data (um) and/or temporal interval can easily be displayed in every tile of the gallery. Z- or t-galleries 
can be saved as an image in a database for quick future reference. Additionally, a subset of images 
within a stack can be selected and stored for later use (e.g. to create a 3-D projection).  

1. Click Gallery in the Display toolbar of the image window. A gallery of the entire stack is automatically 
generated and the Gallery toolbar becomes available in the image window. Click Save if you want to 
save the gallery to your database for quick future reference. Otherwise, a gallery view can always be 
generated from the stack at a later time. 

2. For z-stacks taken over a time series, refer to the Gallery menu to select the format in which you'd 
like the gallery be displayed - Z , Time , or entire z-stacks over time, Z + Time . 

3. To have the stack data (z distance or time interval) displayed in every tile of the gallery, click Data in 
the Gallery toolbar. Use the color selection button (located below Data ) to ascribe a color of your 
choice to the gallery data display.  

4. To separate a subset of images from the full image gallery, select Subset in the Gallery 
toolbar. Here, define new start and end points of the series using the Start Slice  and End Slice  
sliders/data fields, or enter a value in the Every n-th Slice field if you would rather create a subset of 
every n-th slice of your choosing. 

3-D Projection 

The Projection function can render a single projection or a series of calculated projections at set angle 
increments around the X, Y, or Z axis. The user can choose between manipulating aspects of the 
projection's transparency or creating a projection that has maximum intensity.  

The "Transparent" projection method decreases the brightness of each file in the projected stack to 
reveal structure in subsequent layers that would otherwise be hidden. The "Maximum" projection 
method takes the intensity values of individual pixels in all sections and collapses them into one single 
illuminated image. The "Maximum" method is chosen when the maximum pixel intensity is desired to 
be represented in the projection.  

Creating a maximum projection is described here. These instructions assume that an image stack is 
open and therefore available for projection. 

1. Select 3D View> Projection from the main menu. The Projection window will open. 

2. Select the stack to be projected in the Source panel of this window.  

Only stacks and images that are currently open are available for selection in the Source pulldown 
list. 

3. To create an en face (straight-on) projection of all slices in the z-axis, select the Y radiobutton in the 
Projection panel. Leave the First Angle set to 0 degrees, enter 1 in the Number Projections  field, and 
set the Difference Angle  field to 0 degrees.  

4. In the Transparency tab, select the Maximum radiobutton.  

5. Generate the projection by clicking Apply located in the upper right corner of the Projection window.  



The projection calculation can be monitored via the progress toolbar at the bottom of the image 
window. 

6. If a sequence of projections at set angles has been created, it may be animated or viewed in a 
gallery via the Select and Display toolbars of the image window.  

Exporting Files to .tif Format  

Files can be exported in a couple of different ways - via the batch export macro, which allows the 
simultaneous export of multiple database items or the Export of Images function, which allows the 
export of individual database items - be they single confocal sections or a stack. The Export of Images 
method is described here. 

1. Open your database and load (open) the file you would like to export.  

2. Select File>Export  from the main menu. The "Export Images and Data" window will open. 

3. In the Save In  field, designate to which drive or directory the exported data should be saved.  

4. Enter a name for the exported image or series of images in the File name  field.  

5. In the Save as type  field, select the image format into which the file should be exported.  

When selecting an image format, pay heed to whether you are exporting a single confocal image or a 
series (stack) of confocal images. Various image formats are supported (e.g. .bmp, .jpg), we 
recommend TIF (.tif) format as it is lossless and widely usable.   

For multi-channel images, you have the option of exporting individual color channels of data in 
monochrome (grayscale) if Raw data single or Raw data series image type is chosen. 

6. Click Save.  

When a z- or time stack file is exported, each stack slice is stored as an individual TIF image with a 
3-digit numbered suffix appended to the designated file name. 

Assigning Macros To Buttons In Macro Control 

1. Open the software and click Macro main menu item.  

2. Select Macro that now appears in the bottom right corner of the main menu toolbar. This opens the 
Macro Control window.  

3. Click on the Assign Macro to Button panel.  

4. Indicate which button you want the new macro assigned (Button1, Button2, Button3, etc) from the 
drop down menu in the Button field.  

5. Name the new button in the Text field. 

6. Click the ... button beside the Project field to link a macro of your choice to the newly created 
button. An Open window appears. All macro programs can be found in the C:AIM\Macros folder. 

7. Find the macro file that you want to load. Select this file and click on Ok in the Open window.  

8. Select the macro name from the drop down menu of the Macros field. 

9. Hit Apply and the macro you selected should be assigned to the button you designated in step 4. In 
a moment, the specified button will appear in the Macro toolbar. 



Deleting A Macro From A Button In Macro Control 

1. Working under the Macro main menu item, select Macro that appears in the bottom right corner of 
the main menu toolbar. This opens the Macro Control window.  

2. Click on the Assign Macro to Button panel.  

3. Choose which button you want to disassociate from its macro in the drop down menu in the Button 
field. 

4. Press Delete to delete the linking of the macro program to the button. The specified button should 
then ghost out to a blank n.n format. 

Initializing User Software Settings - Running Registry Files 

1. Logon to the system using your ASADMIN user name and password. Make sure that the domain is 
"ASADMIN" (not LSM510 or Biology).  

2. Run all the registry files in the folder on the desktop: 

Double-click each of the files, after each file, you should see a dialog box confirming the registry 
has been successfully updated. Click "OK" to these messages.  

You will need to rerun LSM-Macros.reg whenever you want to use a newly installed macro (e.g. 
newer version of multitime).  

3. Start the LSM510 software as normal - "Scan New Image" & "Start Expert Mode"  

4. In the Options menu, click the Settings submenu. Make the following settings in the different tabbed 
sections of this submenu. 

Program Start: 

- Select FITC (Cy2) from the pull down list or whatever configuration you wish the software to load 
by default every time you log on.  

- Un-select "don't show logo"  

Save: 

- Select the third radio button - at "Create Database" automatically create a subdirectory with the 
same name as specified database and create dataset image files in that subdirectory.  

Temporary Files: 

"Use RAM" is fine unless you're doing time lapse, then you may want to set a temporary location, 
e.g. to your server directory:  

h:ASADMIN\Bio-lemming\Confocal\lab name\user name or use "Save To Disk"  

Import/Export: 

Set location of files; click "User Default Path" to use your default directory defined by your user 
profile  

Record/Reuse: 

Check all but objective  

  


